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SCOPUL ACESTUI MANUAL 

Aceste instrucţiuni descriu etapele necesare pentru transmiterea prin Internet 
a declaraţiilor fiscale, conform Ordinului ministrului finanţelor publice 
nr.858/2008, publicat în Monitorul Oficial nr.242/28.03.2008.  
Pentru a putea folosi acest serviciu, trebuie să deţineţi un certificat digital 
eliberat de un furnizor autorizat. 
Se pot depune în acest mod următoarele declaraţii:  
• 100 Declaraţie privind obligaţiile de plată la bugetul de stat  
• 101 Declaraţie privind impozitul pe profit 
• 102 Declaraţie privind obligaţiile de plată la bugetele asigurărilor sociale şi 

fondurilor speciale 
• 103 Declaraţie privind accizele 
• 120 Decont privind accizele 
• 130 Decontul privind impozitul la ţiţeiul din producţia internă 
• 300 Decont de taxă pe valoarea adăugată 
• 301 Decont special de taxa pe valoarea adăugată 
• 390 Declaraţie recapitulativă privind livrările/achiziţiile intracomunitare de 

bunuri 
• 710 Declaraţie rectificativă 
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ETAPELE PE SCURT 

1. Creaţi pe calculatorul dvs. folderul DECEL, unde veţi depune toate fişierele 
acestei aplicaţii, apoi instalaţi programul Adobe Reader. 
2. Descărcaţi formularul de confirmare de pe portalul ANAF. 
3. Completaţi şi transmiteţi formularul de confirmare pe portalul ANAF. 
4. Listaţi, semnaţi şi ştampilaţi formularul 150 care rezultă în urma transmiterii 
pe portalul ANAF a documentului de confirmare şi a completării datelor de 
înregistrare cerute după încărcărea documentului de confirmare. 
5. Prezentaţi formularul 150 împreună cu documentele necesare la Direcţia 
generală a finanţelor publice de care aparţineţi. 
6. Aşteptaţi primirea pe e-mail a dreptului de utilizare a serviciului de 
depunere electronică a declaraţiilor fiscale. 
7.  Descărcaţi formularele de declaraţii fiscale  de pe portalul ANAF. 
8. Completaţi formularele – fără conectare la Internet. Aplicaţi pe formular 
semnătura electronică primită prin certificatul digital. 
9.  Transmiteţi declaraţiile fiscale. 
10.Examinaţi starea declaraţiilor transmise. 
 
 

CERINŢE DE SISTEM 

Sistemul de transmitere prin Internet a declaraţiilor fiscale a fost testat 
utilizând următoarele configuraţii: 
Software: 
1. Windows XP-SP2 
    Adobe Reader 8.1.2 versiune engleză 
    Internet Explorer 6.0 s, Mozilla/5.0 Firefox/2.0 
2. Windows Vista Enterprise 
    Mozilla/5.0 Firefox/2.0 
Hardware: 
Calculator PC, procesor  3 GHz, 512 Mb RAM. 
 
 

INSTALAREA MEDIULUI DE LUCRU 

Înainte de orice operaţie, vă recomandăm să creaţi un folder cu numele DECEL 
(declarare electronică), unde se vor găsi toate fişierele necesare acestei 
aplicaţii. 
 
În primul rând, consultaţi configuraţia hardware solicitată de producătorul 
Adobe, în funcţie de sistemul de operare al calculatorului dvs. la adresa: 
 http://www.adobe.com/products/acrobat/acrrsystemreqs.html .  
 
Apoi descărcaţi aplicaţia Adobe Reader 8.1.2 de pe site-ul producătorului 
Adobe http://www.adobe.com/products/acrobat/readstep2.html  

http://www.adobe.com/products/acrobat/acrrsystemreqs.html
http://www.adobe.com/products/acrobat/readstep2.html
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CERTIFICATELE DIGITALE CALIFICATE 

Conform OMEF 858/2008, începând cu data de 1 mai  2008 certificatele 
digitale se pot solicitata numai de la furnizorii de servicii de certificare, 
acreditaţi în condiţiile Legii 455/2001 privind semnătura electronică, publicată 
în Monitorul Oficial nr. 429 din 31 iulie 2001, cu modificările şi completările 
ulterioare. Acest certificat digital este denumit în continuare "certificat 
calificat". 
Agenţia Naţională de Administrare Fiscală recunoaşte următorii furnizori de 
certificate digitale calificate: 
• CertSIGN  
Calea Şerban Vodă, nr. 133, clădirea C2, etaj 2 Bucureşti. Telefon: 
(+4021)311.99.04 Fax: (+4021)311.99.05 E-mail: office@certsign.ro 
Internet: www.certsign.ro 
 
• S.C. DIGISIGN S.A. 
Str. Av. Petre Creţu nr. 33, Bucureşti, sector 1, 012051.  
Telefon:+40 31 620 1284 Fax: +40 31 620 1291  
E-mail: office@digisign.ro  
Internet: www.digisign.ro 
 
• S.C. Trans Sped S.R.L.  
Str. Despot Vodă Nr. 38, Sector 2, Bucuresti  
Telefon: 021 / 210.75.00, 210.87.00, 212.04.38, 212.04.39, 211.92.89 
Fax: 021/211.02.07 
Email: office@transsped.ro, support@transsped.ro   
Internet: www.transsped.ro  
 
Cei interesaţi să obţină certificate digitale calificate vor lua contact cu furnizorii 
la adresele respective. 

Utilizarea certificatelor digitale calificate 
Descărcaţi documentul de confirmare a certificatului digital calificat de pe 
portalul ANAF, pagina Asistenţă Contribuabili, modulul „Toate formularele cu 
explicaţii” .  

mailto:office@certsign.ro
http://www.certsign.ro/
mailto:office@digisign.ro
http://www.digisign.ro/
mailto:office@transsped.ro
mailto:support@transsped.ro
http://www.transsped.ro/
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Completaţi documentul de confirmare, aplicând semnătura digitală în căsuţa 
„Semnătură utilizator”, folosind certificatul digital calificat pe care îl aveţi deja.  
 
Atenţie ! După ce aţi completat documentul de confirmare şi aţi aplicat 
semnătura, verificaţi dacă puteţi vizualiza detaliile semnăturii, dând click 
dreapta pe aceasta şi apoi apăsând butonul “Show Signature Properties”. Daţi 
apoi click pe butonul “Show Certificate”. Dacă nu aveţi acces la butonul “Show 
Certificate”, înseamnă că sunt erori. În această situaţie problema se datorează 
modului în care s-a realizat instalarea versiunii de Adobe Reader. Pentru 
remedierea situaţiei procedaţi în  felul următor: 
- dezinstalaţi utilitarul Adobe Reader 
- instalaţi versiunea corectă de Adobe Reader. 
 
După efectuarea acestor proceduri încercaţi din nou semnarea documentului.  
De asemenea, la apăsarea pe butonul “Validate Signature” nu trebuie să apară 
erori. 
 
Trimiteţi prin e-mail acest fişier pe adresa autorităţii de certificare care v-a 
eliberat certificatul digital (adresele autorităţilor de certificare sunt în prezent: 
confirmare@certsign.ro, confirmare@digisign.ro şi confirmare@transsped.ro). 
Autoritatea de certificare va verifica datele din documentul dvs. şi va aplica 
semnătura electronică în căsuţa „Semnătură autoritate de certificare”, după 
care va trimite pe adresa dvs. de e-mail documentul confirmat.  
 
Intraţi pe portalul ANAF, apoi navigaţi în meniul Depunere Declaratii si accesaţi 
modulul „Înregistrare certificate calificate”.  
 
Selectaţi (cu butonul Browse) de pe calculatorul dvs. fişierul .pdf conţinând 
documentul de confirmare, apoi îl trimiteţi apăsând butonul TRANSMITE 
DOCUMENTUL.  
 

mailto:confirmare@certsign.ro
mailto:confirmare@digisign.ro
mailto:confirmare@transsped.ro
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În continuare introduceţi următoarele date: 
- codul unic de identificare al agentului economic pentru care veţi transmite 
declaraţiile fiscale; 
- denumirea contribuabilului, unde veţi introduce denumirea agentului  
economic de mai sus;  
- adresa contribuabilului. 
 Apăsaţi apoi butonul SUBMIT pentru transmiterea acestor date. 
 

 
 
Pe ecranul dvs. se va afişa formularul 150 „Cerere pentru utilizarea unui 
certificat digital calificat”, completat cu datele pe care le-aţi introdus mai 
înainte. Apăsaţi butonul TIPARESTE CEREREA pentru a obţine un formular pe 
hârtie.  
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Atenţie: dacă aveţi dreptul să depuneţi declaraţii fiscale 
pentru mai mulţi agenţi economici, apăsaţi link-ul 
„Continuă cu înregistrarea unui alt CUI” şi procedura se 
reia ca mai sus. Este necesar un singur certificat calificat 
pentru a  depune on-line declaraţii fiscale pentru mai 
multe companii. Conform metodologiei existente, persoana 
posesoare a certificatului digital calificat trebuie să fie 
împuternicită de companiile respective. 
 

Obţineţi semnătura şi ştampila agentului economic pentru care veţi depune 
declaraţiile fiscale on-line. Cu această ocazie, solicitaţi şi un document prin 
care contribuabilul vă împuterniceşte să semnaţi declaraţiile fiscale. Depuneţi 
această cerere la Direcţia generală a finanţelor publice judeţeană sau, după 
caz, la Direcţia generală a finanţelor publice a municipiului Bucureşti, în a cărei 
rază teritorială contribuabilul îşi are domiciliul fiscal. Cererea în format hârtie  
va fi însoţită de următoarele documente: 
 -documentul de identitate al solicitantului, în original şi copie; 
 -documentul eliberat de contribuabil, din care rezultă dreptul 
solicitantului de a semna declaraţiile fiscale pentru contribuabil. 
Pe baza documentelor depuse, organul fiscal verifică realitatea datelor înscrise 
în cerere. 
Veţi primi confirmarea dreptului de utilizare a serviciului “Depunere declaraţii 
on-line” prin poşta electronică, la adresa menţionată în cerere. Adresa de e-
mail de la care veţi primi confirmarea activării contului este 
autoritate.MFP@mfinante.ro, având subiectul: „MFP - activare cont”, iar textul 
mesajului va fi de forma: „Contul dvs. a fost activat pentru CUI-ul (ex. 1234). 
Puteţi utiliza serviciul de depunere electronică declaraţii.” 
Din acest moment puteţi depune declaraţii fiscale on-line, pentru contribuabilul 
cu Codul Unic de Identificare de la care aveţi această împuternicire. 

mailto:autoritate.MEF@mfinante.ro
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Reînnoirea certificatului digital calificat 
În cazul în care certificatul digital a fost reînnoit,  nu mai este necesară 
depunerea de acte suplimentare, decât în situaţia în care doriţi să depuneţi 
declaraţii pentru alte firme. 
Accesaţi portalul ANAF, pagina “Declaraţii electronice”, meniul “Reînnoire 
certificate calificate”. În cadrul acestui meniu tot ceea ce aveţi de făcut este să 
depuneţi documentul de confirmare. În prealabil, documentul de confirmare 
trebuie semnat atât de dumneavoastră, folosind noul certificat, cât şi de 
Autoritatea de Certificare. 
În continuare, este prezentată o captură de ecran în care puteţi vedea cum se 
selectează documentul de confirmare cu ajutorul butonului “Browse”, după 
care se realizează transmiterea acestuia prin butonul “Transmite documentul”. 
 

 
 
După ce depuneţi documentul de confirmare,  veţi primi şi un e-mail din partea 
noastră prin care se confirmă faptul că noul număr al certificatului a fost 
introdus în baza de date a ANAF.  
 
Mesajul e-mail pe care îl veţi primi are următorul conţinut :  
 
Contul dumneavoastra a fost actualizat cu noul serial number ..........  
Puteti utiliza serviciul Depunere electronica declaratii.  
 
După ce aţi  realizat aceşti paşi,  puteţi să depuneţi şi să vizualizaţi declaraţiile. 
 

REVOCAREA ACCESULUI LA SERVICIUL DE DEPUNERE ON-LINE 

Pot exista cazuri în care agentul economic care depune declaraţiile on-line 
doreşte să renunţe la acest serviciu; de exemplu, când persoana împuternicită 
să aplice semnătura digitală nu mai lucrează pentru aceeaşi firmă. 
 
În situaţia în care certificatul digital este obţinut de la ANAF 
(certificatele digitale eliberate de ANAF sunt valabile până la data de 1 mai 
2009), revocarea certificatului digital se solicită de titularul acestuia prin 
completarea formularului 141 „Cerere pentru revocarea certificatului digital”, 
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care se descarcă de pe acest portal, pagina Asistenţa contribuabililor, modulul 
Toate formularele cu explicaţii. Cererea pentru revocarea certificatului digital 
se semnează de posesorul certificatului digital şi de către contribuabilul în 
numele căruia a transmis declaraţiile on-line, se scanează şi se transmite prin 
e-mail pe adresa autoritate.MFP@mfinante.ro. 

 

 
 

Dacă revocarea certificatului digital se solicită de o persoană diferită de 
persoana pentru care acesta a fost eliberat, Cererea pentru revocarea 
certificatului digital se depune în format hârtie, semnat şi ştampilat, de către 
contribuabil, la direcţia generală a finanţelor publice judeţeană sau, după caz, 
la Direcţia generală a finanţelor publice a municipiului Bucureşti, în a cărei rază 
teritorială contribuabilul îşi are domiciliul fiscal. Cererea va fi însoţită de 
următoarele documente: 
 - documentul de identitate al persoanei care solicită revocarea 
certificatului digital, în original şi copie; 

- un document eliberat de contribuabil din care rezultă dreptul persoanei 
solicitante de a revoca certificatul digital. 

 
În situaţia în care certificatul digital este obţinut de la o altă autoritate 
de certificare, revocarea dreptului de utilizare a serviciului “Depunere 
declaraţii on-line” se solicită de titularul certificatului calificat prin completarea 
formularului 151 „Cerere pentru revocarea dreptului de utilizare a serviciului 
Depunere declaraţii on-line”, care se descarcă de pe acest portal, pagina 
Asistenţă Contribuabili, modulul Toate formularele cu explicaţii. Cererea pentru 
revocarea dreptului de utilizare a serviciului Depunere declaraţii on-line se 
semnează de titularul certificatului şi de către contribuabil, se scanează şi se 
transmite prin e-mail pe adresa autoritate.MFP@mfinante.ro.  

 

mailto:autoritate.MFP@mfinante.ro
mailto:autoritate.mef@mfinante.ro
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În situaţia în care revocarea dreptului de utilizare a serviciului 
“Depunere declaraţii on-line” se solicită de o persoană diferită de 
persoana pentru care acest drept a fost obţinut, Cererea pentru revocare 
se depune în format hârtie, semnat şi ştampilat, de către contribuabili, 
conform legii, la direcţia generală a finanţelor publice judeţeană sau, după caz, 
la Direcţia generală a finanţelor publice a municipiului Bucureşti, în a cărei rază 
teritorială contribuabilul îşi are domiciliul fiscal. Cererea va fi însoţită de 
următoarele documente: 

- actul de autorizare a funcţionării contribuabilului, în original şi copie; 
- documentul de identitate al persoanei care solicită revocarea 

certificatului digital, în original şi copie; 
- documentul eliberat de contribuabil din care rezultă dreptul persoanei 

solicitante de a revoca dreptul de utilizare a serviciului Depunere 
declaraţii on-line. 

 
Atenţie: prin formularul 151 nu se anulează certificatul 
digital, ci doar dreptul de acces la serviciul de depunere 
declaraţii fiscale on-line. 

 
DACĂ AVEŢI MAI MULTE CERTIFICATE DIGITALE ELIBERATE DE 
AUTORITATEA DE CERTIFICARE MFP 

 
Pentru simplificarea alegerii certificatului corespunzător firmei pentru care se 
depune declaraţia electronică, se recomandă utilizarea unor “porecle” pentru 
certificate. Atribuirea acestor porecle se realizează o singură, dată conform 
procedurii de mai jos: 

a. După importarea certificatului (cu Internet Explorer) se va selecta Tools > 
Internet Options > Content > Certificates. Se selectează certificatul importat > 
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View > Details > Subject de unde se va copia CUI-ul (se află la secţiunea O) > 
Edit Properties > Friendly name, unde se va introduce CUI-ul corespunzător 
firmei. 

b. La semnarea declaraţiei se va selecta certificatul aferent firmei pentru care s-a 
completat declaraţia. Se procedează în felul următor. În Internet Explorer, 
selectaţi Tools > Internet Options >, apoi Content >  Certificates, ca în 
imaginea următoare: 

 

 
 
În fereastra Certificate, selectaţi Details, Edit Properties: 

 
În fereastra Certificate Properties, introduceţi în câmpul Friendly name 

textul dorit de dvs. drept "poreclă": 
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Astfel, la semnarea declaraţiilor, în lista de certificate  vor apare “poreclele”, în 
locul numelui posesorului de certificate şi se identifică mai uşor certificatul care 
corespunde firmei pentru care se depune declaraţia. 

 
 

Vizualizarea declaraţiilor depuse, folosind o anume "poreclă"  
 
Selectaţi certificatul care corespunde firmei pentru care aţi completat 
declaraţia fiscală, apoi apăsaţi butonul OK. În fereastra Security Alert apăsaţi  
butonul Yes. Pentru afişarea declaraţiilor depuse, apăsaţi butonul Vizualizare 
declaratii din meniul principal. Va fi afişată apoi pagina Vizualizare declaratii 
depuse, ca în exemplul de mai jos. Selectaţi codul firmei pentru care doriţi să 
vizualizaţi declaraţiile depuse şi apăsaţi butonul Afiseaza . 
 

 
- se vor afişa declaraţiile corespunzătoare CUI-ului selectat 
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- pentru vizualizarea declaraţiilor corespunzătoare altei firme se selectează din 
aceeaşi listă CUI-ul aferent firmei respective. 
 
În acest fel este necesară o singură autentificare pe portalul ANAF, folosind 
oricare certificat din listă. 
 
 

Exportul şi importul certificatului digital obţinut de la Autoritatea de 
certificare MFP 

În acest capitol este descrisă procedura de export a certificatului obţinut de la 
Autoritatea de certificare MFP şi instalat în browser (ex. Internet Explorer). 
 
Această procedură este foarte importantă, deoarece link-ul primit pe e-mail 
funcţionează o singură dată, după care el nu mai este valabil.  
Cu această procedură certificatul se poate instala cu uşurinţă de câte ori se 
doreşte, de exemplu în următoarele situaţii:  

• defectarea calculatorului ce necesită  reinstalarea sistemului de operare,  
• înlocuirea  calculatorului,  
• depunerea declaraţiilor de pe un alt calculator,  

Reinstalarea este valabilă dacă aveţi certificatul exportat în format .pfx, atât 
local, cât şi pe un dispozitiv extern. 
 

Instrucţiuni de operare pentru Internet Explorer 
 
1. EXPORTUL CERTIFICATULUI 
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Lansaţi Internet Explorer şi selectaţi Tools – Internet Options – Content – 
Certificates.  
 
În fereastra Certificates, selectaţi "Export", iar în fereastra următoare, 
"Certificate Export Wizard", selectaţi Next. În fereastra "Export Private 
Key" bifaţi opţiunea "Yes, export the private key" şi selectaţi apoi butonul 
Next. 
Apare fereastra următoare, unde se selectează Next: 

 
 
 
 În fereastra de mai jos introduceţi parola cu care se exportă certificatul. 
(această parolă va fi folosită ulterior la importul certificatului) şi selectaţi Next 
 

 
 
Apoi, în fereastra următoare "File to Export", alegeţi numele sub care se 
salvează certificatul şi calea unde se salvează. 
 
Dacă operaţiunea de export a decurs cu succes, trebuie să apară ecranul 
următor, la care apăsaţi butonul Finish: 
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2. IMPORTUL CERTIFICATULUI 
 
Lansaţi Internet Explorer şi selectaţi Tools – Internet Options – Content – 
Certificates. Apoi, în fereastra Certificates selectaţi Import.  
În fereastra de mai jos selectaţi certificatul primit de dvs., apoi apăsaţi butonul 
Next: 

 
 
Apoi introduceţi parola cu care s-a exportat certificatul şi bifaţi Mark the 
private key as exportable. 
 

 
 
Apoi, în fereastra de mai jos, selectaţi Next: 
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Dacă operaţiunea de import a decurs cu succes, trebuie să apară ecranul 
următor, la care apăsaţi butonul Finish: 
 

 
 
 

Instrucţiuni de operare pentru Mozilla Firefox 2.0.0.7 
În  meniul din browser mergeţi la:  Tools -> Options -> Advanced -> View 
Certificates. 
 
1. EXPORTUL CERTIFICATULUI 
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Se selectează Backup, se alege calea unde se salvează certificatul,  precum şi 
numele sub care se salvează, se tastează parola de acces la certificate:  

 
 
Se selectează OK. 
 
Se tastează parola cu care se exportă certificatul: 

 
 
Dacă operaţiunea de export s-a realizat cu succes, veţi avea următorul mesaj: 

 
 
 
2. IMPORTUL CERTIFICATULUI 
 
În fereastra Certificate Manager selectează Import. 
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Se tastează parola pentru accesul la certificate. 

 
 
Dacă operaţiunea de import s-a realizat cu succes, veţi avea următorul mesaj: 

 
 

Instrucţiuni de operare pentru Netscape 8.0 
 În  meniul din browser mergeţi la: Tools -> Options -> Advanced -> Manage 
Certificates. 

 
1. EXPORTUL CERTIFICATULUI 
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Se selectează Backup, se alege calea unde se salvează certificatul, precum şi 
numele sub care se salvează, se tastează parola de acces la certificate:  

 
 
Se tastează parola cu care s-a exportat certificatul: 

 
 
Dacă operaţiunea de export s-a realizat cu succes, veţi avea următorul mesaj: 
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2. IMPORTUL CERTIFICATULUI 

 
 
Se selectează Import, se alege calea către certificat, se tastează parola de 
acces la certificate:  

 
 
Se introduce parola cu care s-a exportat certificatul: 

 
 
Dacă operaţiunea a decurs cu succes, veţi avea mesajul de mai jos: 

 
 

DESCĂRCAREA FORMULARELOR DE DECLARAŢII FISCALE 

Accesaţi adresa de Internet a Agenţiei Naţionale de Administrare Fiscală: 
http://www.anaf.ro. Accesaţi apoi pagina Declaraţii electronice,  opţiunea 
Descărcare declaraţii (în partea din stânga a ecranului, meniul vertical). Apare 
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ecranul următor, specific activităţii de depunere prin Internet a declaraţiilor 
fiscale. 
 

  
 
De aici se pot descărca atât formularele de declaraţii, cât şi instrucţiunile de 
completare ale acestora. Formularele se pot descărca în format pdf sau  în 
format zip (fişierul este comprimat, deci este mai mic şi transferul se face mai 
repede, dar apoi necesită decomprimarea, cu programul WinZip. După 
transfer, selectaţi opţiunea SAVE). Pentru a descărca o declaraţie în format 
pdf, faceţi click pe numele acesteia. Se va deschide următoarea pagină (în 
exemplul nostru, am selectat declaraţia 100): 
 



 21

 
 
În această pagina faceţi click pe FILE iar apoi SAVE AS pentru ca fişierul să fie 
salvat pe calculatorul dumneavoastră. Pentru a descărca instrucţiunile de 
completare se procedează în mod similar. 
 
 

COMPLETAREA FORMULARELOR 

 
În cele ce urmează veţi găsi explicaţii privind completarea declaraţiilor din 
punct de vedere informatic. Pentru explicaţii privind natura fiscală a datelor, 
vă rugăm să descărcaţi formularul simplu, însoţit de instrucţiunile de 
completare, de pe portalul ANAF, la adresa: 
http://static.anaf.ro/static/10/Anaf/toate_formularele.htm 
 
Completarea formularelor de declaraţii fiscale se poate face fără a vă conecta 
la Internet. 
Alegeţi fişierul cu declaraţia pe care doriţi s-o completaţi, apoi executaţi un 
dublu-click pentru a lansa în execuţie programul Adobe Reader, cu care veţi 
introduce datele în formular.  
Există următoarele etape în lucrul cu declaraţiile format PDF:  
Obţinerea declaraţiei în format PDF: se face prin descărcarea lor de pe 
portalul ANAF şi salvarea lor pe calculatorul dvs.;  
Deschiderea declaraţiei realizată cu ajutorul aplicaţiei Adobe Reader 8.1.2 ;  
Completarea declaraţiei cu datele dvs.: 
 -  navigarea în cadrul unei declaraţii în format PDF se efectuează cu ajutorul 
tastei „Tab” sau direct printr-un click cu mouse-ul în cadrul unei celule (câmp); 
 - câmpurile ce au ca valoare rezultatul calculat al altor câmpuri sunt colorate 
diferit; nu puteţi să le modificaţi pe toate;   

http://static.anaf.ro/static/10/Anaf/toate_formularele.htm
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 - în cadrul unor declaraţii în format PDF se află un buton „?” poziţionat sub 
denumirea declaraţiei, care la acţionarea cu mouse-ul oferă ajutor pentru 
completarea formularului;    

    
 

Salvarea declaraţiei: dacă se doreşte întreruperea temporară a completării 
declaraţiei şi păstrarea datelor încărcate până la acest moment (în Adobe 
Reader meniul – File – Save as ... );  
Verificarea corectitudinii datelor încărcate: pentru a vă asigura că datele  
introduse sunt cele pe care doriţi să le declaraţi; 
Validarea declaraţiei completate: se realizează prin intermediul butonului 
existent la finalul declaraţiei:  
 

 
 
Validarea are ca scop:  
- verificarea completării câmpurilor minime obligatorii. Ele apar încadrate 
într-un chenar roşu la apăsarea butonului „Highlight fields”. De exemplu, la 
declaraţia 100 se prezintă astfel: 
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-  în cazul în care validarea nu a generat mesaje de eroare sau avertizare, 
declaraţia este pregătită pentru semnarea electronică.   
 
Semnarea electronică a declaraţiei: reprezintă un element foarte important 
pe care vă rugăm să-l trataţi cu mare atenţie:  
 - din punct de vedere tehnic, semnarea electronică reprezintă o modalitate 
prin care se certifică şi se protejează confidenţialitatea datelor înscrise în 
formularul PDF completat; 
 - din punct de vedere practic, semnarea electronică se realizează prin 
intermediul certificatului digital primit  şi instalat pe calculatorul dvs. acţionând 
câmpul special dedicat al declaraţiei tip PDF. În cazul în care există mai multe 
certificate digitale instalate pe calculatorul dvs., selectaţi semnătura adecvată 
contribuabilului pentru care se întocmeşte declaraţia, prin intermediul listei 
derulante corespunzătoare opţiunii „Digital ID”. 
  

 
Apăsarea butonului „Sign” generează o fereastră de salvare distinctă a 
formularului completat şi semnat, cu numele recomandat în finalul formularului 
(Exemplu: declaraţia 100 întocmită pentru luna martie 2007). 
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Observaţie:   
Vă recomandăm să copiaţi denumirea fişierului PDF de 
salvat (prin selectarea textului, click buton dreapta mouse, 
alegere „Copy”) după acţionarea butonului VALIDARE, 
click buton dreapta mouse şi alegerea opţiunii „Paste” în 
cadrul rubricii „File name:” din fereastra „Save As”. 

  
Formularul salvat în etapa anterioară trebuie transmis întocmai, orice 
intervenţie  ulterioară asupra sa, chiar şi simpla lui deschidere fără a efectua 
vreo modificare, conduce la vicierea semnăturii şi neînregistrarea ei. Dacă 
totuşi aţi intervenit asupra formularului după momentul semnării şi salvării, 
atunci trebuie acţionat butonul „Validare” şi reluat procesul semnării. Nu 
recomandăm modificări repetate asupra unei declaraţii urmate de validare, 
semnare şi salvare, deoarece formularul creşte din punct de vedere al 
dimensiunii, îngreunând ulterior transmiterea sa. 
 
Atenţie ! După ce aţi completat formularul aferent declaraţiei fiscale şi aţi 
aplicat semnătura, verificaţi dacă puteţi vizualiza detaliile semnăturii, dând 
click dreapta pe aceasta şi apoi apăsând butonul “Show Signature Properties”; 
daţi apoi click pe butonul “Show Certificate”. Dacă nu aveţi acces la butonul 
“Show Certificate”, înseamnă că sunt erori. În această situaţie problema se 
datorează modului în care s-a realizat instalarea versiunii de Adobe Reader. 
Pentru remedierea situaţiei procedaţi în  felul următor: 
- dezinstalaţi utilitarul Adobe Reader 
- instalaţi versiunea corectă de Adobe Reader. 
 
După efectuarea acestor proceduri încercaţi din nou semnarea documentului.  
De asemenea, la apăsarea pe butonul “Validate Signature” nu trebuie să apară 
erori. 
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DEPUNEREA DECLARAŢIILOR FISCALE 

 
Atenţie: nu lăsaţi transmiterea declaraţiilor pentru ultima 
clipă! Vă expuneţi riscului unui trafic aglomerat pe portalul 
ANAF. Există şi riscul de a nu a putea depune declaraţia în 
termen ! 
 
 

Accesaţi adresa de Internet a Agenţiei Naţionale de Administrare Fiscală: 
http://www.anaf.ro şi apăsaţi butonul Declaraţii electronice din meniu, 
selectaţi apoi pagina Transmitere declaraţii. 
 

 

 
Apăsaţi butonul Browse, selectaţi declaraţia completată pentru transmitere şi 
apăsaţi OPEN. 
 
Spre exemplu, putem considera ca s-a transmis fisierul 
100_0307_J22000010.pdf. El a fost iniţial formularul gol al declaraţiei 100, 
cu numele de fişier D100-V1.pdf, aşa cum a fost descărcat de pe portalul 
ANAF. 
 
Vă recomandăm ca, pentru declaraţia completată, să folosiţi numele de fişier 
propus de program; astfel se va şti că s-a transmis declaraţia 100 pentru 
luna martie, în anul 2007, pentru agentul economic cu codul fiscal 
J22000010.  
 
Apăsaţi apoi butonul Transmite Declaraţia.  
 
Un document transmis cu succes va fi urmat de un mesaj de tipul următor: 

http://www.anaf.ro/
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Puteţi să vă opriţi aici, deoarece declaraţia a fost înregistrată la ANAF. Dar 
puteţi să mai trimiteţi altă declaraţie, sau să vedeţi numărul cu care a fost 
înregistrată.  
 
 

VIZUALIZAREA DECLARAŢIILOR DEPUSE PRIN INTERNET 

Vizualizarea declaraţiilor depuse necesită logarea pe portal. Pentru logare 
apăsaţi butonul LOGIN (marcat cu roşu, sus, în dreapta paginii) 
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Dupa aceea, apăsaţi butonul PREZENTARE CERTIFICAT :  
 

 
 
Din fereastra “Choose a digital certificate”, selectaţi certificatul dvs., cu care 
vă conectaţi pe portalul ANAF. 
După selectarea certificatului, apăsaţi butonul OK. În fereastra următoare 
apăsaţi  butonul Yes: 
 
 

 
 
 
 
După logare, pentru afişarea declaraţiilor depuse, apăsaţi butonul Vizualizare 
declaraţii din meniul principal. Va fi afişată apoi pagina Vizualizare declaraţii 
depuse, ca în exemplul de mai jos. Selectati codul firmei pentru care doriţi să 
vedeţi declaraţiile depuse. 
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Atunci veţi primi următoarele informaţii: 
 

 
 

RECIPISA 

Observaţi că pentru fiecare depunere există asociată o recipisă. Dacă faceţi 
click pe aceasta, veţi obţine următorul ecran: 
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Puteţi salva această recipisă (click dreapta, „Save target as...”) şi denumiţi 
fişierul cu numărul de înregistrare al documentului asociat. Aceasta este 
dovada dvs. că aţi depus respectiva declaraţie la data specificată în recipisă. 
 
Dacă doriţi să verificaţi semnătura electronică a celui care a emis recipisa – ea 
este a Serviciului de depunere declaraţii din cadrul ANAF – trebuie să urmaţi 
instrucţiunile de mai jos: 
1. În modulul Declaratii electronice, daţi click pe "Verificarea recipisei".  
2. Instalaţi programul jdk-1_5_0_09-windows-i586-p.exe în folderul 
C:\Program Files\Java. 
3. Descărcaţi aplicaţia VerificaRecipisa din aceeaşi adresă. Dezarhivaţi 
aplicaţia, folosind programul WinZip, în discul C: 
4. Creaţi folderul C:\Recipisa din cadrul meniului Depunere declaraţii. În acest 
folder veţi pune recipisele, în vederea verificării. 
5. Rulaţi aplicaţia de verificare prin dublu click pe verifica_recipisa.bat, din 
folderul C:\VerificaRecipisa. Aceasta va citi toate recipisele existente în acest 
folder.  
Dacă recipisa a fost semnată corect va apărea mesajul:  
Documentul ...  a fost semnat corect de catre .... . 
 
 

MESAJE PRIMITE DUPĂ PRELUCRAREA DECLARAŢIEI 

După prelucrarea declaraţiei dvs. la unitatea fiscală de care aparţine 
contribuabilul, se pot primi următoarele mesaje: 
 

Mesaje obţinute la depunere 
 
• Stare: Documentul depus este o declaratie fiscala.  
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Acest mesaj apare dacă documentul depus este o declaraţie validă 
(documentul conţine codul formularului, perioada de raportare şi CUI-ul). 
Dacă primiţi acest mesaj, atunci depunerea se poate considera efectuată. 
Pentru a afla dacă declaraţia este completată corect, urmăriţi în 
continuare mesajele ce apar,  până ce vedeţi mesajul Declaraţia a fost 
prelucrată. Dacă în locul acestui mesaj veţi obţine mesaje care indică 
erori la prelucrare, veţi fi contactat de Administraţia finanţelor publice 
respectivă; depunerea se consideră invalidă şi trebuie să repetaţi 
procedura de depunere după corectarea erorilor, folosind formularele şi  
respectând instrucţiunile de completare prezentate în modulul 
Descărcare formulare. 
 

• Documentul depus nu este o declaratie tip pdf sau nu este semnat cu un 
 certificat digital. Va rugam refaceti depunerea. Daca eroarea persista 
 sunati la 319.98.89/int. 175, sau trimiteti email pe  adresa 
 admin.portal@mfinante.ro 
 Acest mesaj indică faptul că declaraţia depusă nu este semnată cu 
 certificat digital. Vă rugăm să respectaţi instrucţiunile pentru depunerea 
 electronică a declaraţiilor. 
 
• Stare: Documentul depus nu conţine o declaraţie fiscală. Nu există cod 

formular. Vă rugăm să refaceţi documentul utilizând formularele şi 
instrucţiunile de completare prezentate la  Descărcare formulare.  
Acest mesaj apare în cazul în care documentul trimis nu are codul 
formularului. Aceasta eroare poate să apară numai în cazul în care 
încercaţi să folosiţi alte formulare decât cele existente pe site în 
secţiunea Descărcare formulare. 

  
• Stare: Documentul depus nu conţine o declaraţie fiscală. Nu conţine luna 

din perioada de raportare. Vă rugăm să refaceţi documentul utilizând 
formularele şi instrucţiunile de completare prezentate la Descărcare 
formulare.  
Acest mesaj apare în cazul în care documentul trimis nu are completată 
luna din perioada de raportare. Aceasta eroare poate să apară numai în 
cazul în care încercaţi să folosiţi alte formulare decât cele existente pe 
site în secţiunea Descărcare formulare. 

 
• Stare: Documentul depus nu conţine o declaraţie fiscală. Nu conţine anul 

din perioada de raportare. Vă rugăm să refaceţi documentul utilizând 
formularele şi instrucţiunile de completare prezentate la Descărcare 
formulare.  
Acest mesaj apare în cazul în care documentul trimis nu are completat 
anul din perioada de raportare. Aceasta eroare poate să apară numai în 
cazul în care încercaţi să folosiţi alte formulare decât cele existente pe 
site în secţiunea Descărcare formulare. 

 
• Stare: Documentul depus nu conţine o declaraţie fiscală. Nu corespunde 

codul din document cu codul din certificat. Va rugăm verificaţi că aţi 

mailto:admin.portal@mfinante.ro
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introdus corect CUI-ul şi că ati semnat cu certificatul corespunzător. Vă 
rugăm să refaceţi documentul şi să efectuaţi o nouă depunere.  
Acest mesaj apare în cazul în care documentul trimis nu are completat 
corect codul de identificare fiscală. Aceasta eroare poate fi datorată 
completării incorecte a codului de identificare fiscală. De exemplu, codul 
real este 19578 şi s-a introdus 19577. Comparaţia se face între codul 
introdus în document şi cel din certificatul cu care s-a semnat 
documentul. Depunerea se consideră invalidă şi trebuie repetată 
procedura de depunere, cu remedierea erorilor, prin folosirea 
formularelor şi a instrucţiunilor de completare prezentate pe site, în 
secţiunea  Descarcare formulare. 

 
• Stare: Documentul depus nu conţine o declaraţie fiscală. Semnătura este 

invalidă. Vă rugăm să refaceţi documentul utilizând formularele şi 
instrucţiunile de completare prezentate la Descarcare formulare.  
Acest mesaj apare în cazul în care documentul semnat a suferit 
modificări după semnare, înainte de a fi transmis. Acest caz este ipotetic 
dacă se utilizează formularele de pe site, deoarece modificarea 
documentului după semnare produce automat ştergerea semnăturii şi 
imposibilitatea salvării documentului cu modificări ulterioare semnării lui. 
Depunerea se consideră invalidă şi trebuie repetată procedura de 
depunere, cu remedierea erorilor, prin folosirea formularelor şi a 
instrucţiunilor de completare prezentate pe site, în secţiunea  Descarcare 
formulare. 

 
 

Mesaje primite în urma verificării declaraţiilor la organul fiscal competent 
 

• Informaţii după prelucrare: Declaraţia a fost prelucrată.  
 
• Informaţii după prelucrare: Declaraţia a fost prelucrată şi au fost 

identificate erori. Veţi fi notificat pentru corectarea acestora. 
Erorile provin de la corelaţiile din cadrul declaraţiei – sume calculate, 
totaluri, verificări cu alte declaraţii, etc. 

 
• Informaţii după prelucrare: Declaraţia nu a fost prelucrată. Fişierul 
 transmis este eronat.  
 Nu se respectă conţinutul standard al fişierului (include şi faptul că 
 fişierul conţine aceleaşi date cu ale unei declaraţii depuse anterior) sau 
 informaţiile referitoare la codul fiscal, perioada de raportare, tipul 
 formularului sunt eronate. 
 
● Informaţii după prelucrare: Declaraţia nu a fost prelucrată. Fişierul 
 transmis are erori de completare. Verificaţi sumele 
 datorate/deductibile/de plată şi de recuperat. Erorile provin de la 
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 corelaţiile din cadrul declaraţiei 100 – a se citi instrucţiunile de 
 completare pentru rândurile 1, 2, 3, 4.  
 
• Informaţii după prelucrare: Declaraţia nu a fost prelucrată. A mai fost 

depusă o declaraţie pentru aceeaşi perioadă.  
Nu se acceptă depunerea mai multor deconturi de TVA pentru aceeaşi 
perioadă de raportare. 

 
• Informaţii după prelucrare: Declaraţia nu a fost prelucrată. Contribuabilul  
 nu este înregistrat ca plătitor de TVA.  

Pentru declaraţii depuse de contribuabili care nu sunt înregistraţi ca 
plătitori de TVA la organul fiscal de care aparţin. 
 

• Informaţii după prelucrare: Declaraţia nu a fost prelucrată. Contribuabilul 
este înregistrat ca plătitor de TVA trimestrial.  
Pentru declaraţii depuse la alte perioade de raportare decât trimestrul – 
lunile 3, 6, 9 ,12. 

 
• Informaţii după prelucrare: Declaraţia nu a fost prelucrată. Contribuabilul 

este înregistrat ca plătitor de TVA semestrial.  
Pentru declaraţii depuse la alte perioade de raportare decât semestrul – 
lunile 6, 12. 

 
• Informaţii după prelucrare: Declaraţia nu a fost prelucrată. Contribuabilul 

este înregistrat ca plătitor de TVA anual.  
Pentru declaraţii depuse la alte perioade de raportare decât anul – luna 
12. 

 
• Informaţii după prelucrare: Declaraţia nu a fost prelucrată. Codul de 

identificare fiscala este eronat.  
 
• Informaţii după prelucrare: Declaraţia nu a fost prelucrată. Vă rugăm să 

folosiţi alt canal de depunere a declaraţiei.  
 
 Dacă mesajul este altul decât “Declaraţia a fost prelucrată”, veţi fi 
 notificat pentru corectarea acestora de către administraţia finanţelor 
 publice de care aparţineţi, fiind totodată informat de erorile conţinute de 
 declaraţia depusă. 
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